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Congratulations on your purchase of the Canon BJC-620 Color Bubble Jet Printer. We appreciate
your choosing this printer to meet your printing needs.

Your printer features the Microsoft Windows Printing System, which makes printing from
Microsoft Windows faster and easier than ever before. With the Microsoft Windows Printing
System, your printer is able to print faster than traditional approaches. As soon as the Microsoft
Windows Printing System accepts a document for printing, you can return to your application.
You receive instant notification of printer information and you can see the printer's status on your
computer screen.

The BJC-620 offers exceptionally high print quality and fast print speed using both color and
black inks. We are certain you will be satisfied with its advanced Bubble Jet technology.

This chapter:

o Lists the supplies and accessories you can purchase for the printer
o Describes Canon's customer support services
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Supplies and Accessories

Your BJC-620 printer supports excellent and unique print media options that will allow
you to produce dazzling, professional, and fun presentations. All of these print media
are specially designed and manufactured to work with your Canon color printer so you
can produce the finest output possible.

J 4 Canon has an extensive dealer network equipped to offer you supplies as you need
J them. To find a dealer near you, call the Canon Referral Servie8(Q-848-4123.

If supplies are not available from your local dealer, you can order directly from Canon
by calling1-800-671-1090.

Ink Tanks

Your BJC-620 comes with the following ink tanks:

e Canon Ink Tank BJI-201 Bk HC (black, high capacity)
e Canon Ink Tank BJI-201 C (cyan)

e Canon Ink Tank BJI-201 M (magenta)

e Canon Ink Tank BJI-201 Y (yellow)

Canon Specialty Paper

Canon manufactures various specialty papers, including:

Bubble Jet Paper LC-301 (water resistant)
Coated Paper LC-101

High Resolution Paper HR-101
Transparency CF-102

Back Print Film BF-102

High Gloss Film HG-101

Fabric Sheet FS-101

T-Shirt Tranfers TR-101

Greeting Cards GC-101

Brochure Paper BP-101

See Chapter Raper Handlingfor details on Canon's specialty papers.
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Getting Help From Canon

Canon provides experienced support personnel to help you in every way

Ej;l On-line Support Services
@ You can easily contact Canon on the World Wide Web. Our address is:

http://www.ccsi.canon.com

Canon provides a bulletin board service (BBS), which is useful for obtaining newly
developed third-party drivers. Ca757-420-2000The protocol for the BBS is up to
28,800 bps, eight data bits, one stop bit, and no parity.

If you use CompuServe®, You can access the Canon Peripherals Forum. This allows
you to talk with other users, send a message to Canon, or download printer drivers.
Just type GO CANON at any CompuServe prompt.

o If you have a modem, you can connect to Canon through the Web, its BBS, or
Compuserve. Through these on-line services, you can retrieve general
information about specific products.

o If you are looking for information about any Canon printer driver for a unique
situation, you can contact one of the Canon on-line services.

¢ You can retrieve information from the on-line services at any hour of the day or
night.

Fax Retrieval System

Canon provides a 24-hour, toll-free Fax Retrieval System. You can use this service to
";ﬁ; get helpful documents faxed directly to your fax machine. These documents contain
E*H\ﬁ; useful information to assist you in the operation of your Canon printer. To access this
" service, calll-800-526-4345.

o One of the first things you may want to do after setting up your printer is call the
Canon Fax Retrieval System and request an index of the documents available to
you through this service. Documents will be faxed directly to your fax machine.

o The Fax Retrieval System offers up-to-date information about specific products.
By reviewing the index, you can determine what information would be beneficial
to your installation.
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é&; Customer Care Center

Canon provides customer support and service for all Canon printer products. If you
have any questions regarding your new printer, call the Canon Computer Systems
Customer Care Center hi800-423-2366Support is available from 6 A.M. to 12
MIDNIGHT Eastern Standard Time. (EST) Seven days a week except holidays.

o If you seem to have an operational problem, try to solve it by using the Super
Solver. If you cannot quickly resume normal operation, contact Canon's
experienced support personnel at the Customer Care Center.

Servicing the Printer

The Canon BJC-620 Color Bubble Jet Printer is designed with the latest technology to
provide trouble-free operation. The warranty information at the back of the manual
describes Canon's limited one-year warranty for its Bubble Jet printers. Be sure to read
the warranty information to find out about the different service options available to

you.

42? Save your sales receipt for proof of purchase. In the event that your printer needs
wom  Service, you will need your proof of purchase to obtain warranty service.

If you feel your BJC-620 Color Bubble Jet Printer needs servicing, contact Canon on
the World Wide Web to locate the Canon Authorized Service Facility (ASF) nearest
you or to find out about the exclusive Canon Instant Exchange warranty program. If
you do not have access to the Web, call the Customer Care Center.
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Using the Microsoft
Windows Printing |2
System
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This chapter introduces you to the Microsoft Windows Printing System
for the BJC-620. It includes:

e Understanding the Microsoft Windows Printing System

¢ Printing with the Microsoft Windows Printing System

¢ Using the Microsoft Windows Printing System program group
o The Microsoft Windows Printing System dialog boxes

o Overview of the Microsoft Windows Printing System

o Checking the status of a print job

e Using the Status Window

e Customizing display options

e Maintaining the printer from the Status Window
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Understanding the Microsoft Windows
Printing System

The Microsoft Windows Printing System manages the communications between your
computer and printer. It divides the work between the two, helping the printer and
computer work together to optimize performance.

The Microsoft Windows Printing System processes documents from Microsoft Windows
applications faster than traditional methods, and lets you quickly see the status of your
print job. If you install the included sound files, your computer will actually tell you
verbally what your printer is doing.

Checking the Computer Requirements

Your Quick Start Guidelescribes how to install the Microsoft Windows Printing
System. To use the system, make sure your computer system has the following minimum
configuration:

e 386SX 16MHz personal computer

e 10 MB of physical and virtual memory combined, of which at least 4 MB must be
physical RAM

e VGA or super VGA color graphics monitor

e 6 MB of available disk space for full installation of Microsoft Windows Printing
System

e Microsoft Windows 95, Microsoft Windows 3.1, or Microsoft Windows for
Workgroups 3.1

o Parallel printer port with bi-directional communication capability

The printer may not print some pages at high resolution with the system above. In this
case, the following are suggested.

e 486SX 25MHz personal computer
e 16 MB of physical and virtual memory combined, of which at least 8 MB must be
physical RAM

42? You need a sound card to play sounds with the Microsoft Windows Printing System
wem Messages.
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Printing With the Microsoft Windows
Printing System

One-way communication from computer to printer has been the standard for years.
The Microsoft Windows Printing System offers dynamic two-way communication.
With the Microsoft Windows Printing System, your computer knows what your
printer is doing.

To take advantage of the dynamic two-way communication, one end of a bi-
directional parallel cable connects to the printer and the other end connects directly
to your computer

You must use a bi-directional cable for proper operation. Also, your computer's
interface must have bi-directional capability. If your computer tells you that it cannot
find the BJC-620 printer, but the printer is plugged in, turned on, and connected to
the computer, see the Technical Notes starting on page 5-11.

N

Every time you print, the Microsoft Windows Printing System displays the Status
Window. This window shows you the paper moving through the printer, how long it
will take to print the document, and how much of the document has printed. From
the Status Window you can pause, resume, force, or delete the print job, print the
self test, or clean the print heads.

Canan BIC-E20 an LPT1: =]

Printer  View (ptions Help

Printer Ready
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If a printing problem occurs, the Status Window automatically opens and tells you
what the problem is.

Before using the Microsoft Windows Printing System, make sure you have selected it
as your current Microsoft Windows printer driver. The Setup program makes the
Microsoft Windows Printing System the default printer driver. If you have not
changed drivers since running the Setup program, you are ready to print.

To verify that the Microsoft Windows Printing System is your printer driver, use the
Printers option in the Microsoft Windows Control Panel. The highlighted driver is the
current printer driver. Change drivers by clicking on the one you want.

Using On-line Help

The Microsoft Windows Printing System includes extensive on-line help that
describes the printer and its basic operation. You can get on-line help as follows.

Microsoft Windows 95

o In the Properties dialog box:
o Use the right mouse button to click an item on the screen.
o Click the ? button (on the upper right corner of the screen) and then click
an item.
o Press1.

Select Programs from the Start menu, then click on Canon BJC-620 Help in the
Microsoft Windows Printing System folder.

Microsoft Windows 3.1

e Choose the Help button or prdsswhile in the Setup dialog box.
o Double-click on the Canon BJC-620 Help icon in the Microsoft Windows
Printing System group.

2-4 Using the Microsoft Windows
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Using the Microsoft Windows Printing
System Program Group

When you install the Microsoft Windows Printing System, you create the
Microsoft Windows Printing System program group, from which you can select
the following:

]

Printers Folder

=

Canon
BJCEZ0
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Printer Setup

Print Manager

&

Canon
BJIC-E20
Uinimstallation

Canon BJC-620 Installation

Starts the installation program for the Microsoft Windows Printing
System. You can use this program to add features to the Microsoft
Windows Printing System that you did not originally install.

Canon BJC-620 ReadMe

Provides you with the latest information about using the Microsoft
Windows Printing System with your printer.

Printers Folder

Opens the BJC-620 Properties dialog boxes, which you can use to
set the printing options for Microsoft Windows 95.

Canon BJC-620 Status Window

Displays the Status Window so you can check the status of a print
job.

Canon BJC-620 Help

Selects the Canon BJC-620 Help file for the
Microsoft Windows Printing System.

Printer Setup

Selects the Printer Setup dialog box, which
you can use to sete printing optionsn

Microsoft Windows 3.10r Microsoft Windows for
Workgroups 3.1.

Print Manager

Selects the Microsoft Windows Print
Manager for Microsoft Windows 3.1 or
Microsoft Windows for Workgroups 3.1.

Canon BJC-620 Uninstallation

Starts the program to uninstall the Microsoft
Windows Printing System.

2-5 Using the Microsoft Windows Printing System Chapter 2



From Microsoft Windows 95
From the Microsoft Windows 95 Printer folder:

1. Click the Start button, point to Settings, and then click Printers.
2. Click the icon for the printer you are using.
3. On the File menu, click Properties to open the Properties dialog box.

From Microsoft Windows 3.1
Use the Control Panel or Print Manager:

1. Open the Control Panel, then double-click on the Printers icon to open the
Printers dialog box. Or open the Print Manager, then choose the Printer
Setup... command from the Options menu to open the Printers dialog box.

You can open the Control Panel or the Print Manager by doubleclicking on the
Control Panel or Print Manager icons in the Main group of the Program

Manager.
2. In the Printers dialog boxes, make sure BJC-620 on LPTI is highlighted and

then choose the Setup... button to open the Setup dialog box.

42? You can open the Printer Setup dialog box, Print Manager, or Printers folder from

wow  the Microsoft Windows Printing System group.

The way you get to the dialog boxes determines how long the printing options remain
in effect:

« If you start from an application's Print... command, your choices apply only to
that print job. The next time you print, you have to choose the print settings
again.

e If you start from an application's Print Setup... command, the application stores
your choices with the document.

« If you start from the Control Panel or Print Manager, the settings apply to all
Microsoft Windows applications and remain in effect until you change those
settings.

2—7 F)smg the Microsoft Windows Chapter 2
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Many applications do not follow the above Microsoft Windows
@ guidelines. Until you are familiar with how your Microsoft Windows
ot application uses the Microsoft Windows Printing System settings, it's a
good idea to verify the settings each time you print.

Overview of the Microsoft Windows
Printing System

The Microsoft Windows Printing System dialog boxes, where you
select printing options, differ depending on whether you are using
Microsoft Windows 95 or Microsoft Windows 3.1 or Microsoft
Windows for Workgroups 3.1.

Microsoft Windows 95
You select printing options with the following tabs.

e General
Prints a test page and a separator page.

ADD
COMMENTS

HERE = PRINT A

SEPARATOR
FRGE

— PRINT ATEST PAGE
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o Details
Specifies printer port settings and timeout settings.

= DEFINE THE
FRINTER'S PORT

SFECIFY THE
PRINTER DRIVER

== SPECIFY TIMEQUT

SETTINGS
SPECIFY
SPDOL SPECIFY POAT
SETTINGS EETTINGS

o Copies & Methods
Specifies multiple copies, collated or not, and the print orientation.

SPECIFY
MUMEBER OF
COPIES

SPECIFY PAGE
ORIEMNTATION

SPECIFY ——
COLLATION
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e Size & Source
Chooses the paper source and paper size.

SPECIFY

SPECIFY PAPER SIZE

PAPER

SOURCE

e Graphics & Color
Chooses the paper source and paper size.

SPECIFY
COLOR
MODE

SPECIFY

HALFTOMIMG

METHOD
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e Quality
Chooses the resolution setting, print media, and print quality. The resolution
settings are Draft (180 x 180 dpi), Normal (360 x 360 dpi), and Best (720 x

720 dpi).

T

] e | St B S|
! [
=Y — -
SPECIFY —— =l E — : ﬁil = SPECIFY
RESOLUTION | (| PAPER

ilr—"'-" | TYPE

For detailed information on the Microsoft Windows Printing System
printer options settings, refer to the on-line help.

Microsoft Windows 3.1 or Microsoft Windows for Workgroups 3.1
You select printing options in the following dialog boxes.

e Printer Setup dialog box
This is the first dialog box you open from your application
program. You can select multiple copies, collated or not collated,
paper orientation, paper source, and paper size.

B seaemmae | SPECIFY

PAGE

SPECIFY ——F - weae [0 [ | S e ORIENTATION
cOPESAND | =W (SRR || 0 e R
COLLATION p...m—“,i;-- ——— [ OPEN QUALITY
T —|_|:1w.alsamc
SPECIFY § D U M ) OPEN
PAPER T e o = | GRAPHICS
SOURCE . DIALOG BOX
e ) SPECIFY
| Popes G st Fomd ] | Fopes e [ Bzt~ H FAPER SIZE
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You open the Quality and Graphics dialog boxes from the Printer Setup dialog box.

o Quality dialog box
Selects media type. printer resolution, and print quality. The resolution
settings are Draft (180 x 180 dpi), Normal (360 x 360 dpi), and Best (720 x

720 dpi).

SELECT MEDMA
TYPE AND
RESOLUTION

SELECT PRINT
CHIALITY

Eoba e Inch [dg] . w'n

7% Migh Spand [Tasd & Graphecr) !"'?..-- . 3
| |l
W High Gwality [ow D

T Mads and Heaokubon

Mais 15

Gualiey

471 Hiph Dusy Gsphecs

Tl[)
| () Phvstosachic Duskes Eg —

e Graphics dialog box
Selects the haiftoning method, adjusts brightness. contrast, and saturation,
enables gray scale printing, and disables the Microsoft Windows Printing
System color matching

SELECT ——
HALFTOMNING
METHOD

SPECIFY
BRIGHTMESS

| - r
[ firew Ssie Prietivns

DMSABLE COLOA
MATCHIMNG

SELECT GRaAY
SCALE PRINTING

- RESTORE

DEFALILT
SETTINGS

SPECIFY
CONTRAST

SPECIFY
SATLIRATION
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For detailed information on the Microsoft Windows Printing System printer options
settings, refer to the on-line Help by pressing the Help button or by préssing

o When your computer is connected to a network, you can also open the

Sharing tab.
42? e For optimum print quality when you select 720 x 720 dpi, choose Smooth
Note haiftoning from the Graphics dialog box or Graphics & Color tab. We also

recommend using Canon High Resolution Paper (HG-101).

Checking the Status of a Print Job

With the Microsoft Windows Printing System, you can keep track of and control
your print jobs using the Status Window. It tells you exactly what is happening with
the current print job. You can use the Status Window to pause, resume, or delete
the current print job, and you can access on-line help for the Microsoft Windows
Printing System.

While you are working in the Status Window, remember that you can get on-line
help at any time by choosing commands from the Microsoft Windows Help menu or
by pressing-I.

o When you install the Microsoft Windows Printing System into Microsoft
Windows 3.1 or Microsoft Windows for Workgroups 3.1, the Print Manager
helps you control and manage all print jobs in a queue for all printers installed
for Microsoft Windows.

e When your computer is connected to a network printer, the "Status Not
Available Network Printer" message always appears in the Status Window.
That is, you cannot check the status of the printer or control the printer,
except to print a test page. The Status Window for the network printer
appears on the network printer server, which is connected locally to the
printer.
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Using the Status Window

The Status Window uses animated 3-D graphics to illustrate the printer and the
document being printed.

MIMIMIZE BUTTOM
= Canon BJC-G20 on LPT1:
Printer  Wiew Options Help MEML BAR
= A 17 §ER TOOLEAR
[Printing: Rolepad - README. TAT
Entimatad tima lofi 114 geconds JOB INFORMATION
Estimated time Gnished: 554 PW AMND MESSAGES

1 Page Printed

AMIMATED GRAPHIC SHOMWING
THE PRINTIMG PROCESS

m.‘l Pages Printed | PROGRESS BAR
| [Frinting, | STATUS BAR

Opening the Status Window

The Status Window opens automatically in the following cases:

o When you print with the Microsoft Windows Printing System-unless you
previously turned off the Display Printer Status While Printing option (see
page 2-18).

o When the Microsoft Windows Printing System encounters an alert that
requires your intervention before you continue printing (see page 2-17).

The Status Window always opens the way you left it last, either full size or as an
icon that indicates the general condition of the printer (printing, idle, and so on).

When you install the Microsoft Windows Printing System into Microsoft Windows
g 3.1 or Microsoft Windows for Workgroups 3.1, the Print Manager is enhanced and
ot you can open the Status Window by clicking the printer info button on the toolbar
in the Print Manager.
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Using the Toolbar
The toolbar has six buttons:

Pause Printing

To temporarily halt printing the current
document, click this button. The Microsoft
Windows Printing System finishes printing the
current page, but will not print the remaining
pages until you click the Resume Printing button.

Ei Resume Printing
' To continue printing after a pause, click this
button.

Force Printing

To force printing of the current print job, click
this button. The Microsoft Windows Printing
System forces printing on a paper size that is
different from the one originally selected for the
document.

E Cancel Printing

To cancel printing the current print job, click this
button.

&/ Print Test Page
To print the test page, click this button.

g Quick Clean

To clean the print head unit, click this button.
The printer performs Quick Cleaning. See
Chapter 4Maintaining the Printeifor details.

Using the Status Window as an Icon

You can make the Status Window appear as an icon by clicking on the Minimize
button in the upper right corner of the window. The icon tells you all you want to
know about the print job.

A progress bar appears above the icon when a document is printing. When the job is
finished, the icon changes to show a stack of printed pages. Other icons indicate
when the printer is idle, when the Microsoft Windows Printing System has detected a
condition that requires either your eventual or immediate attention, and when the
status of the printer is not available.
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Printer Ready
When the printer is ready, the icon looks like it does during printing,
but without the progress bar.

&

Printing Done
When the printing has finished, a stack of pages appears on the
printer.

Printing Paused
When printing is paused, the icon shows mark.

Printer Warming Up
When the printer is preparing for printing, the icon shows an
hourglass.

Information

When the Microsoft Windows Printing System has an information
message, the icon shows a large (i) and blinks to get your attention.
To read the text of the message, restore the Status Window to its full
size.

2 e W

Attention Required

When the Status Window displays an alert, the window automatically
opens to its full size. You can, however, minimize the window to an
icon showing the exclamation mark (!) that identifies an alert.

%

Even if you minimize the alert, you will not be able to resume printing
until you take the action specified in the full-size window.

2-16 Using the Microsoft Windows Printing System Chapter 2




Messages Displayed in the Status Window

The Microsoft Windows Printing System gives you complete
information about your print job and the printer itself. There are three
categories of messages:

li Information messages notify you of a condition that does not
- | require immediate action.

{D Alerts require your intervention before printing can proceed.

@ During operations such as print head cleaning, messages
inform you that the printer is preparing for printing. When
these messages appear, wait for a moment.

Other messages, such as Printer Ready, appear to keep you informed
about your printer.

The messages are easy to understand and the solution to the problem is
generally straightforward.

For on-line help, you can always pré$or use the Help menu.

If you installed the sound files, the Microsoft Windows Printing System
accompanies each message with a distinctive sound or spoken message.
You can turn the sounds off by using the Display Options dialog box

(see theCustomizing Display Optiorsection on page 2-18).
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Customizing the Status Window

The Status Window always displays job information. However, the
View menu allows you to set the four components (Toolbar, Printer

animation, Progress bar, and Status bar) to display in the Status
Window.

You cannot resize the Status Window, but you can make more room on

the screen by showing fewer components. For example, you could limit
the Status Window to the Toolbar and the Progress bar.

‘Canpk BJC-BZ0 mn LFTIC

“Erinter flew (ptions _Help — MENU BAR
.3 i T TOOLBAR
Falntiege bcrasod Wosd - WIEW. DDC
|| Estimated dme iesr: &} paconds
|| Estimeted dme finmhad: 55 MESSAGE AREA

1 Pagn Prlrﬂ:d_."-.____

— FRINTER ANIMATION

PROGRESS BAR

STATUS BAR

Customizing Display Options

Use the Status Options dialog box to control when the Microsoft
Windows Printer System displays the Status Window and whether
sound accompanies each message.

[ Pranben Slatias Wirdow

- Diwplay Printer Stabuz Wndos sbls ponding |
4.0 Dindy display Printer Stabtus Window Ioe sirors LE

" Sounds

% Play oll sounds —&:I—I

20 Dy play maireng soueds

20 e mol, plag arp sounds
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e You can open the Status Options dialog box from the Option menu in the
Status Window.

e You can use the Microsoft Windows Control Panel to turn individual sounds
on or off.

¢ You can change display options even as a document prints, but the changed
settings will not take effect until the next print job.

Maintaining the Printer from the Status Window

You can perform the following operations for maintaining the printer
from the Status Window:

e Print a Test Page
You can print the same test page as that printed out when
installing the Microsoft Windows Printing System. You can check
the printer and software operation by printing a test page. You
can also check the condition of the print head.

Since the test page is printed with the currently selected printing
options, such as Dots Per Inch or Print ~uality, you can verify the
output with the settings.

o Align the Print Head Unit
You can align the print head unit. Print head alignment is
necessary when you have print quality problems with the initial
printing after installing or replacing the print head unit.

e Clean the Print Head Unit
You can clean the print head unit with three kinds of cleaning
procedures: Thorough, quick, and Custom.

You can print a test page with the Print Test Page button and perform
the quick cleaning with the quick Clean button on the Toolbar in the
Status Window.

You can also perform the above operations in the Printer Options dialog
box, which can be opened from the Status Window.
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The Printer Options Dialo

g Box

You can perform the printer maintenance operations from the Printer Options dialog

box.

PRINTS & TEST PAGE
ALIGNS PRINT HEAD —

Primles Options

Paimits beel pagm that varifiee holl pantm
anul yaftmme homchonabty,

Pamita thee alignment page and prowiden
conhols bn abgn He perd hasd

[ Cleas Prind Heacks —

- Hung the selected pind heal cleamng
muzthand

PERFORMS PRINT
HEAD CLEAMING ]
) Thmough Fing complels Cloammg O
ercha loi all prind Baads
1 FOR PRINT HEAD
INSTALLATION QR A B ok Fiuns auick clesn ior sl prind
SEVERE PRINT heads.
QUALITY PROBLEMS O Cusiomc  Claans sskected puint hasds. @
1 FOR PRINT ———— | Ciince Bl O Hoserts  ER
QUALITY [ Orpan Bl Dot ]
PROBLEMS L~
FOR INK TANK ————— o

INSTALLATION

SPECIFY COLOR OF INK TAMK

FOR CLUSTOM CLEANIMNG

To display the Printer Options dialog box, open the Status Window and then select
Printer Options... from the Options menu.
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Paper Handling |3
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This chapter describes how to use the printer for all your printing operations. It
includes:

Selecting paper

Setting the paper thickness lever

Setting the paper selection lever and the paper support
Summary of printer settings for various print media
Automatically feeding paper

Manually feeding paper

Printing on envelopes

Using Canon's specialty papers

To ensure the best performance of your printer, you'll want to select the best
paper and load it correctly. You can stack paper in the sheet feeder to load it
automatically, or you can manually feed one sheet at a time. The path that the
paper travels through the printer is the same for automatic and manual feeding.
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Selecting Paper Types

One of the most important things you can do to assure the best possible print
guality from your Bubble Jet printer is to select the correct paper. Your printer
produces letter quality output on most plain bond papers, including cotton bond
and photocopying papers; it does not require special ink jet papers. However, the
print quality varies with different paper types. Be sure to test a type of paper
before you purchase a large quantity.

.
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Plain Paper

The printer supports paper sizes of letter, legal, and A4 in portrait orientation. You
can use regular copier paper, cotton bond papers, and typical letterhead. Always
use paper without curls, folds, staples, or damaged edges.

Bubble Jet Paper (water resistant)

The Canon Bubble Jet Paper LC-301 has been developed for high quality printing
with minimal or no smearing or running when in contact with water or damp
surfaces, making it a good choice for damp or rainy environments. The paper is
specially coated and printable on both sides.

Coated Paper

Canon's Coated Paper LC-101 is specially designed for your BJC-620 printer,
which will produce sharp and vivid color output on this high grade matte paper.
The coating used on this paper is a unique formula that ensures full compatibility
with your Canon color inks. Use this paper for your printer output that requires
crisp color rendering on a high quality, nonglossy paper.
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High Resolution Paper
The Canon High Resolution Paper HR-101 is designed to produce photographic
quality print output with sharp and vivid graphics.

Transparencies
Transparency CF-102 from Canon is recommended. These transparencies produce
excellent contrast, sharpness, and color.

Back Print Film

Canon Back Print Film BF-102 has been specially developed for Canon Color Bubble
Jet printers. The film is designed to deliver brilliant, high intensity color images
suitable for business presentations, design work, or professional reports. Back print
film is printed on the back (nonglossy) side of the film in mirror image and then
viewed from the front or glossy side using a backlighting device. For more detalils,
ask a Canon Authorized Dealer for information or refer to the manual supplied with
the film.

High Gloss Film

The Canon High Gloss Film HG-101 features a bright white finish that lends striking
visual power to charts, graphs, and photographic images. Use this film to make your
presentation materials and graphics look professional.

Fabric Sheet

Use Fabric Sheet FS-101 for Canon Bubble Jet printers to print banners, pillow
covers, scarves, flags, and other textile items. Use these sheets for applique and other
craft and sewing projects. Fabric sheets are 9.5 x 14 inches.

T-Shirt Transfers

Use Canon's popular T-Shirt Transfers TR-101 to create and personalize T-shirts,
sweatshirts, aprons, tablecloths, napkins, tote bags, and anything else your
imagination allows! Use on any cotton or cotton/poly blend fabric. Your image is
printed in mirror image (when you use T-Shirt Transfer mode through the BJC-620
Printer Driver) so when you iron it onto the T-shirt, the image is viewed correctly.

Greeting Cards

Get the most out of your Canon Creative or other card-making software with Canon
Greeting Cards GC-101. These cards give your unique, personalized cards the look
and feel of professional cards. You can create cards, invitations, announcements, and
more.
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Brochure Paper

Canon's Brochure Paper BP-101 is specifically designed for creating high quality
brochures on glossy paper. Combined with Design Essentials from Canon

Creative, you have everything you need to create professional half-fold, tn-fold,

and full sheet brochures. Each glossy sheet is coated on both sides to allow manual
duplex printing.

If you are printing in an application outside Windows, your software application or
42? printer driver must support mirror image printing in order to use Back Print Film
Mote or T-Shirt Transfers.

Paper Guidelines

When selecting or loading paper, keep these guidelines in mind.

e Attempting to print on damp, curled, wrinkled, or torn paper can cause
paper jams and poor print quality.

e Use cut-sheet paper only. You cannot use multipart paper.

« If the print density of your page is very high, light paper stock may curl
slightly due to the large amount of ink. If you need to print heavy graphics,
try printing on a heavier stock.

o Do not use thicker paper than meets the specifications for this printer.
Printing with a paper that is thick enough to come in contact with the print
head nozzles may damage the print head unit.

e For the best printing results, follow the instructions included with the paper.
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Before Loading Paper
To ensure trouble-free paper handling, you'll want to set the paper thickness lever and the
paper selection lever before loading paper.

Setting the Paper Thickness Lever

You use the paper thickness lever to adjust the distance between the print head and the
paper to accommodate different paper thicknesses. This distance is cgtiedttap.

Set the lever according to the thickness of the paper you are using:

o Down is for printing on plain paper and normal weight (such db@grint media.
e Up is for printing on heavier-weight print media (such as fabric sheets) and envelope
(See page 3-8 for details).

Paper Thickness Lever

Always set the paper thickness lever before and after printing on heavier-weight print medi

wow O envelopes.

If you are printing documents with high density graphics or ink and the printed pages are
smudged, try setting the paper thickness lever to the up position. This moves the grint hea
unit further from the paper. Print quality may diminish slightly but the smudges should go
away.
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Setting the Paper Selection Lever
and the Paper Support

Set the paper selection lever and the paper support to their proper
positions before loading paper.

« When automatically loading a stack of paper, set the paper
selection lever to the back position and extend the paper support.

« When automatically loading a stack of envelopes, set the paper
selection lever to the front position and extend the paper support.
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« When manually feeding any type of print media, set the paper
selection lever to the front position and lower the paper support.

o Do not move the paper selection lever after loading paper in the
sheet feeder.

e This lever is different than the lever on a typewriter or dot matrix
printer. You need not pull it forward to load paper. You set the
paper selection lever to the front position only when loading
envelopes or when manually feeding paper. If it is set to the front
position when you are automatically feeding stacks of normal
paper, the printer may feed multiple sheets or jam.

When the paper selection lever is in the back position, a lever inside the
printer prevents the paper from advancing into the printer. When you
move the paper selection lever to the front position, the lever inside the
printer moves so that the single sheet being manually fed can advance
into the printer.
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Printer Settings for Various Print Media

The following table summarizes the printer settings for the various types of print media:

Paper
Paper thickness

type lever

Paper
selection
lever

Paper
support

Loading
method

Stack
(sheets)

Plain paper  Down

Bubble Jet

Paper Down
(LC-301)
Coated Paper
(LC-101)

High
Resolution
Paper (HR- Down
101)

Transparency
(CF-102)  Down
Back Print

Film Up
(BF-102)

High Gloss

Film Down
(HG-101)
Fabric Sheet
(FS-101)
T-Shirt
Transfers Up
(TR-101)
Greeting

Cards Up
(GC-101)
Brochure

Paper Up
(BP-101)

Other heavier
weight print  Up
media
Envelopes
Stacked Up
Single Up

Down

Up

Back

Back

Back

Back

Back

Back

Front

Back

Front

Front

Front

Front

Front
Front

Up

Up

Up

Up

Up

Up

Down

Up

Down

Down

Down

Down

Up
Down

Automatic

Automatic

Automatic

Automatic

Automatic

Automatic

Manual

Automatic

Manual

Manual

Manual

Manual

Automatic
Manual

100

100

80

80

50

50
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Automatically Feeding Paper

You can place approximately 100 sheets of plain paper or Bubble Jet
paper (17 |Ib or 64 g/?m in the sheet feeder at a time.

You can stack approximately 50 sheets of transparency film, back print
film, or high resolution paper in the sheet feeder. However, these
special print media may not advance correctly under unusual
environmental conditions (such as extreme temperatures and humidity).
If you have trouble with special papers becoming skewed or feeding
multiple sheets, do not stack them in the sheet feeder. Load them
manually as described later in the chapter (page 3-15).

To automatically feed plain paper, follow these steps:

D)

Make sure the
paper thickness
lever is down
for printing on
plain paper-.

Paper Thickness Lever
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Make sure

the paper
selection lever
is set to the
back position

Extend the ¢ Pull the paper support up until it stops. The paper support keeps

paper support paper straight and limits the possibility of jams.

and paper  , Extend the paper output tray
output tray.
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A

Fan the paper.

5

Slide the stack
of paper into
the sheet
feeder until

it stops.

For best results, fan the paper before loading it.
Always fan a stack of paper along the edge that will feed into the
printer first.

Align the edge of the paper with the right edge of the sheet
feeder.

Do not force the paper into the printer.

Insert the paper so that the side you want to print on is facing
you. If you are using a preprinted stock, such as letterhead, insert
the top of the paper into the sheet feeder first.

Make sure the stack of paper does not exceed the paper limit
mark on the right side of the sheet feeder.
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6

Adjust the * This keeps the paper feeding straight into the printer and reduces

. skewing.
paper guide e Be sure there is no gap between the paper guide and the edge of
to the stack the stack of paper.
of paper.

Start printing. o Make sure the printer is turned on and on-line.
e Start your print operation.
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Auto Feed Guidelines

When automatically feeding stacks of paper, follow these guidelines.

Do not leave paper stacked in the printer for long periods of time;
longer sheets of paper may become bent or curled over time. This
may cause the paper to misfeed or jam.

If your printed page contains lots of graphics, the ink on the page
may be damp due to the print density. Remove the page right away
and allow the ink to dry.

The capacity of the paper output tray is 20 sheets of paper. To
reduce paper jams, remove paper from the output tray before the
count reaches 20.

If paper curls after printing, remove it immediately; otherwise, paper
jams may occur.

The platen (a roller on the inside of the printer) may become inked if
you print data beyond the width of the page. If this happens, clean
the platen with a soft cloth. (For details on cleaning the platen, see
Chapter 4, Maintaining the Printer.)

Depending on the density of your printed pages, the ink may need
time to dry. Within two to three seconds, the ink becomes smudge
resistant.

Do not try to load paper into the sheet feeder beyond the paper limit
mark on the right side of the sheet feeder; stacking too much paper
may cause paper feeding or printing problems.

Limit Mark
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Make sure there are no gaps between the stack of paper and the
paper guide nor the right edge of the sheet feeder.

NO GAP
HERE

When automatically feeding transparencies or back print film,
remove each sheet after it is delivered. Do not allow film sheets
to stack up in the paper output tray.

Place at least one sheet of plain paper in back of a stack of
transparencies or back print film to avoid paper jams and
misfeeds.

Let the printed sheets of film dry completely before storing them.
The complete drying time required for color printing on Canon's
transparencies or back print film is approximately 15 minutes. The
complete drying time required for solid black printing on this
media is approximately 30 minutes. You may be able to reduce
the drying time if you reduce the density setting in your
application before printing.

If printing at 720 x 720 dpi in black on back print film appears
blurred, switch to 360 x 360 dpi or reduce the density setting in
your application.

If printing in black on transparencies is not as crisp as you
expected, reduce the density setting in your application.
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e When a sheet of film has dried completely, cover its printed side with a
sheet of plain (not coated) paper before storing it; this is recommended
even if you place the sheets of film in a clear file.

For best results when printing on special papers, follow the instructions that

wow COme with the paper.

Manually Feeding Paper
You use the manual feed function when printing on heavier-weight print media
(24 Ib to 28 Ib or 91 g/m2 to 105 g/m2) or high gloss film.

To manually feed a single sheet, follow these steps:

@D

Make sure
the printer is
turned

on and on-line.

e The POWER, ON LINE, and PRINT MODE lights are on.
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Open the top  * If you are manually feeding heavier-weight print media, set the

cover and check paper thickness lever to the up position. (See page 3-8 for
details).

the paper | you are printing normal weight (20 ib) print media, set the lever
thickness lever. down.

PAPER THICKNESS LEVER

ED

Set the paper
selection lever
to the front.
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I | |
e
Insert the ¢ Slide in the paper until it stops inside the sheet feeder.

o Align the sheet with the right edge of the sheet feeder.
o Adjust the paper guide to the sheet.

single sheet.

5

Start printing. o Be sure to select Manual Feed in the Setup dialog box of the Microsoft
Windows Printing System.
o Make sure the printer is on-line.
e Start your print operation.

g

o After printing on heavier-weight print media or envelopes, set the paper
thickness lever (inside the printer) to the down position before printing
on normal paper.

o After manually feeding a sheet of paper or an envelope, set the paper
selection lever to the back position.
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Printing on Envelopes

You can stack up to 15 envelopes in the sheet feeder or you can manually feed
envelopes one at a time.

U.S. Commercial number 10 (COM 10) envelopes and European DL envelopes are
recommended. You may be able to stack envelopes of other sizes in the sheet feeder;
however, Canon cannot guarantee consistent performance on envelope sizes other
than COM10 and DL.

The following envelopes are not recommended because they may cause jams or
smears, or may damage your printer.

o Envelopes with windows, holes, perforations, cutouts, and double flaps.
o Envelopes made with special coated paper or deeply embossed paper
o Envelopes using peel-off sealing strips.

o Envelopes in which letters have been enclosed.

Preparing Your Software
How you create envelopes within your software application depends on the
application. See your application's documentation for details.

If you are using the Microsoft Windows Printing System, change the Paper Size
setting to #10 or DL.
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Check your software to see if it prints envelopes in portrait or landscape
orientation. It's a good idea to print on a sheet of paper before printing on an
envelope to check the orientation.

iN

Printing on envelopes in portrait orientation results in faster printing. However,
several software packages, such as WordPerfect® and Word for Windows,
default to landscape orientation. This requires adjustments in the software to
correctly print on envelopes with this printer. See your software documentation
for details.

Loading Envelopes

When you are ready to print on envelopes, follow these steps to stack envelopes
in the sheet feeder. (You can also manually feed envelopes one at a time.)

1

Set the ¢ The lever points upward.
green paper
thickness
lever
to the up
position.

PAPER THICKNESS LEVER
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Set the o Make sure the paper support is extended.
paper selection  * Move the paper guide to the left to match the width of the

envelopes.
lever to
the front.
Prepare the ¢ Arrange the stack of envelopes on a firm surface and press down
firmly on the edges to make the folds crisp.
envelopes :
e Press around the envelopes to remove any curls and expel air
from inside the envelopes.
e Press firmly on the area that corresponds to the edges of the flap.
/j\\\‘ -
y S
A —t ] |
PRESS DOAWN FIRMLY ON
THE EDGES OF THE FLAP
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o Slide a stack of envelopes into the sheet feeder until it stops
Insert the o Align the stack of envelopes with the right edge of the sheet
envelopes. feeder.

Adjust the paper
guide to

the stack of
envelopes.

&

Start printing. o Make sure the printer is on-line.
e Start your print operation.
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When printing on COM10 envelopes, move the paper guide all the way to the left.
Depending on the size and shape of your interface connector, the paper guide may

wow touch it. If this causes the envelopes to misfeed, use an interface cable with a
smaller connector.

Using Canon's Specialty Papers

This section describes how to use the cleaning sheet that comes with the Canon
High Resolution Paper and how to use the Fabric Sheets for Canon Printers.

Canon's High Resolution Paper HR-101

Canon's High Resolution Paper HR-101 is designed for high quality printing. This
paper is specially coated to produce delicate color output. After using a package of
High Resolution Paper (200 sheets), you need to use the cleaning sheet enclosed
with the paper to remove paper dust from the printer's rollers; this will help prevent
paper feed problems.

Using the Cleaning Sheet

ad
Setup e« Make sure the paper thickness lever (inside the printer) is down-for normal
the paper. , : .
. o Make sure the paper selection lever is to the front and the paper support is
printer. lowered-for manual feed.
o Make sure the paper output tray is extended.

/
f

,,.:I@/ Iy

L

/f - :E:_H—‘;:::‘:; |

- &
- o ER
- kT

3-22 Paper Handling Chapter 3




 Remove the two pieces of tape from the sheet.
Insert the Insert t_he sheet with the sticky side out (toward you) and down
(going into the sheet feeder).
o Adjust the paper guide to the edge of the cleaning sheet.

cleaning sheet.

Feed the
cleaning sheet.

Turn off the printer by pressing the POWER button.

e Press and hold the FF and PRINT MODE buttons and press the
POWER button until the printer beeps.

e The printer advances the cleaning sheet and starts cleaning.

e The printer feeds the sheet and then ejects it.

e Use a cleaning sheet once only.
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Fabric Sheets FS-101

Fabric sheets FS-101 for Canon printers come with a booklet that describes special
handling procedures. Be sure to look through this booklet for special information
regarding the Fabric Sheets. This section describes specific steps for using Fabric
Sheets with the BJC-620.

Be sure to follow these guidelines.

e To avoid paper jams, smearing, and other problems, do not open the printer's
cover during printing.

o Use the fixing agent that comes with the Fabric Sheets FS-101.

o Do not touch newly printed fabric sheets until the ink is completely dry. This
takes about one hour.

Printing On a Fabric Sheet

Setup ° Make sure the paper thickness lever (inside the printer) is up for heavier-
the weight print media.
o Make sure the paper selection lever is to the front and the paper support is
lowered for manual feed.
o Make sure the paper output tray is extended.

printer.
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Maintaining the |
Printer (4
00000 0 90 0 O 0

This chapter covers the care and maintenance required for your
Canon BJC-620 Color Bubble Jet Printer. It includes:

Printer guidelines

Cleaning the printer
Cleaning the print head unit
Replacing an ink tank
Replacing the print head unit
Transporting the printer

Printer Guidelines

Follow these guidelines to avoid damage to your printer and
harm to you or others:

e Set the printer on a stable surface. Do not use an angled
printer stand. Avoid setting the printer in direct sunlight.

o Keep the front cover closed when printing.

o Do not set anything on top of the printer.

o Always use a three-wire, grounded power receptacle
(electrical wall outlet with three holes) for your printer’s
power cord. Do not modify the cord or remove the
ground pin.

o Make sure the power is off any time you connect or
disconnect the power cord or interface cable.

e When unplugging the power cord, always remove it by
holding the plug and not the cord.
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e Do not unplug the printer unnecessarily. The printer may clean
the print head nozzles and consume a small amount of ink when
you plug it into an AC outlet or a power strip.

o Never unplug the printer or turn off a power strip to which the
printer is attached when the printer's power is turned on. This
may prevent the print head unit from returning to the home
position. Once in the home position, the print head unit and the
ink tanks are capped, which prevents them from damage or
drying out. This is critical. If left uncapped, the print head unit
may clog and may need to be replaced.

o For reliable data communications between your computer and the
printer, use a short cable, six feet or less in length. The cable must
be bi-directional.

e Do not move the mechanism that holds the print head unit and ink
tanks. Attempting to move the carriage may damage delicate
mechanical parts.

CARRI&GE

e Do not touch the print head nozzles on the print head unit. Ink
may leak out and cause stains. Also, you may permanently
damage your print head unit, which would require you to
purchase a replacement.

e Do not touch the white padding inside the ink tank. Ink may leak
out and you may damage the tank.
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Cleaning the Printer

Clean the
platen and
its
surrounding
area inside
the printer

Your printer requires little routine maintenance. Perform the following
maintenance, as necessary, to keep your printer in good operating condition.

Be very careful when cleaning the printer. Make sure the printer is turned off;
then unplug it.

Use a soft cloth to remove any ink mist or paper debris.

Do not rub the gear wheels.

Do not use any oil or cleanser inside the printer.

When cleaning inside the printer, avoid the area near the print head unit and
ink tanks. Do not touch the print head nozzles. Ink may leak out and cause
stains.

e Do not move the print head unit from the home position.

o Do not use paper products (such as paper towels or tissues) to clean the
inside of the printer. They may leave paper particles inside the printer.

CAREFLILLY
CLEAN INSIDE
THE PRINTER
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Clean the e Use a soft cloth moistened with water.
e Clean any smudges or dust.

exterior o : . . e
f e Do not clean the exterior of the printer with volatile liquids such as
' the thinners, benzine, or any spray-type or chemical cleaners; doing so will
printer. damage the surface of the printer.

Cleaning the Print Head Unit

The print head unit contains nozzles through which color ink is propelled onto
the paper. The print head nozzles must be free from paper particles and dust in
order to maintain a high level of print quality.

The printer has an automatic cleaning function that clears away paper particles
and dust when you turn on the printer afteas been turned off for a certain
period of time.

You need to activate the print head cleaning procedure whenever you replace the
print head unit or individual ink tanks, or when your print quality is poor. There
are three types of print head cleaning:

e Thorough cleaning of all print head nozzles
A new print head unit needs to be cleaned to ensure the best possible print
quality. Also, you must perform a thorough cleaning if you insert the ink
tanks in the wrong slots or if quick cleaning does not solve your print
guality problems. This procedure takes about three minutes.

e Quick cleaning of all nozzles
Use this method to improve print quality. This cleaning takes about two
minutes.

e Custom cleaning of selective print head nozzles
Use this method to clean the print head nozzles of a new ink tank or if one
color is not printing as clearly as you think it should. This cleaning takes
about one minute.
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Using the Microsoft Windows Printing System

When you use the Microsoft Windows Printing System, perform the print head
cleaning from the Printer Options dialog box. See page 2-20 for detalils.
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Using the Operator Panel

If you are not using Microsoft Windows, you can select the print head cleaning
method from the printer's operator panel. When you pre$3RH¢T MODE button

repeatedly, you cycle through the cleaning types as follows:

Indicator lights
Bk C M Y C(leaning type

#  # # #  Thorough cleaning

® @ @& @ Quickcleaning of all four heads

® O O O Custom cleaning of black print head

2 @ O 3 Custom cleaning of cvan print head

2 O @ O Custom cleaning of magenta print head
2 D O @ Custom cleaning of yellow print head
2 O O O Cancel cleaning selection process

@ On O Off % Blinking
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Start cleaning
Make sure the printer is turned on.

@D

« Hold these buttons until the printer beeps and the INKE=Id: i
e Press th@RINT MODE button until the appropriate lights are

Press the
PRINT MODE
and =
buttons at the
same time

PRINT MODE BUTTON

D

Press the =1 o The printer starts the selected print head cleaning procedure.
buttons until the When the print head cleaning procedure is complete, the indicato

printer beeps

To cancel the print head cleaning selection process, preBRthE v
noe are off. Then press the button.
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Ink Tank Guidelines

Use only the BJI-201 ink tanks with this printer.

To ensure excellent print quality and to avoid spilling ink, always follow these
guidelines:

o Be sure to install all four ink tanks. Attempting to print without one or more
of the ink tanks in place causes HRROR andINK lights to come on and
the printer does not operate.

o Always install the ink tanks in the correct slots. If you install an ink tank in
the wrong slot, the color inks may mix with each other in the printer and the
new ink tank may be spoiled.

o Do not remove an ink tank untilig empty or six months after opening it,
whichever comes first.

e Do not attempt to move the mechanism that houses the print head unit and
ink tanks.

e Each ink tank has a sponge portion, and the top of the sponge is always
white. This is normal and does not indicate a partially full tank.

e The ink inside the tanks appears much darker than the color that prints on a
sheet of paper.

The contents of an ink tank may leak. Spilled ink may permanently stain any surface
or object. Open ink tank packages carefully; follow all instructions on package and
caution se all necessary precautions.
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To avoid spilling ink, follow these precautions:

o Do not attempt to disassemble or refill an ink tank.

o Do not vigorously shake an ink tank while handling it.

e Do not stick anything into the opening on the ink tank.

e Do not unpack an ink tank until you are ready to install it.

Canon's limited warranty does not cover damage that is attributable to
the use of third party parts or supplies, including inks. The limited
warranty remains in effect for its life once that particular damage has
been properly repaired.

Hole

Replacing an Ink Tank

Canon makes numerous ink tanks; the BJI-201 ink tanks are designed
A specifically for the BJC-620 Color Bubble Jet Printer and are the only
caution ones Canon recommends that you use.

1)
Make sure ¢ Press and hold tH@N LINE button until the printer beeps.

the printer  ® This caps the print head unit.

is turned on
and on-line
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@
Open the

printers
cover.

e Grasp each side and lift up.

Do not open the print head unit compartment cover inside the printer. You can

v €asily remove and install the ink tanks with this cover closed.

Remove the ¢ Liftup the front of the old ink tank and slide it out of its slot.
Id o Dispose of it properly. You may want to place it in a plastic bag to keep
° from spilling any ink.
ink tank.

If the ink tank appears to contain ink, reinstall it making sure it is seated
correctly. Perform the single-head cleaning procedure for the ink tank. If the
Nete  ERROR and INK lights still come on, replace the ink tank.
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e
Open the new ink  ® Carefully remove the new ink tank.

e Be very careful--if you spill any ink, it may be very difficult to

tank by following remove

the instructions
on its package.

Slide the
new ink tank
into its slot.

Press down on
the top of the
ink tank.

Do not attempt to move the mechanism that houses the print head unit
note and ink tanks
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D

Check each
ink tank.

(&>

i

Perform the
custom cleaning
procedure for the
new ink tank you
just installed.

A

Caution

g

o Make sure each ink tank is correctly seated in its respective slot.
e Close the printer's cover.
e Presf®ON LINE to set the printer back on-line.

e If you are using the Microsoft Windows Printing System, see
page 2-20.

e If you are not using the Microsoft Windows Printing System, see
page 4-5 for details.

Be sure all four ink tanks are properly installed. If you attempt to print
without one or more of the ink tanks in place, the ERROR and INK
lights come on and the printer does not operate.

When you turn off the printer, the print head unit moves tttmee
positionon the right and caps each ink tank. This keeps the ink tanks
from drying out. The print head nozzles will not be properly capped and
the print head unit may clog or be permanently damaged in the
following cases.

e If you unplug the printer while it is printing.

e If you turn off a power strip to which the printer is attached while

it is printing.
e If you move the print head unit from the home position.

If, after installing a new ink tank, the printer seems to be printing but
one or more of the ink colors does not appear, stop the print operation.
Make sure the ink tanks are seated properly in the correct slots. If
necessary, clean the print head unit as described earlier in this chapter.
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Replacing the Print Head Unit

With proper use, the print head unit should last the life of the printer. Eventually,
however, as the print head unit wears out, the print quality will deteriorate and you
will see irregular or missing dots on printouts. If this occurs and print quality does not
improve with repeated print head cleanings, contact the Canon Computer Systems
Customer Care Center to find out your service options (seelpage

Print Head Unit Guidelines

The most important thing you can do to extend the life of your BJC-620 and to
ensure optimum print quality is to take care of the print head unit. To avoid damaging
the print head unit, follow these precautions:

Do not touch the print head nozzles on the print head unit or the sharp edges
around them.

Do not place the print head unit on a table with the print head nozzles facing
down. Make sure the filters are facing up if you must set the print head unit
down.

Install the print head unit immediately after you open it.

Replace an empty ink tank as soon as possible. Do not attempt to print a color
for which the ink tank is empty.

Do not use heavier-weight print media than meet the specifications for this
printer. (See Appendix ASpecificationsfor details.) Printing with a paper that

is thick enough to come in contact with the print head nozzles may damage the
print head unit.
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Removing the Used Print Head Unit

Remove the print head unit only when you have a new one available (otherwise
your ink tanks may dry out). To remove the used print head unit, follow these
steps:

D
e Open the printer’s cover.
¢ Remove the four ink tanks and set them aside for now.

Turn off the o Be sure to set them upright on a level surface with their number
, labels facing up.
printer o Do not remove the print head yet.

+ Close the cover

o

« Press and hold down ti#€, print mope and = buttons and press the

Turn on the rower button until the printer beeps. This empties the ink from the print
. head unit.
prinfer . Open the printer's cover.

C3 })
Open the Press in on the tabs on the sides of the cover and lift it up.

compartment
cover.

TERMINALS
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@ Do not touch the terminals on the inside of the compartment cover.
Naole

Remove the print
head unit.

o Dispose of it properly.
o Follow local guidelines for disposal.

Installing a New Print Head Unit

Make sure the power cord is attached and the power is off.
o

Take the new
print head unit
out of its
protective
packaging.

-"u“ R

el |l
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Remove the ¢ Do not remove the gray-padded material around the silver filters.
e Avoid touching the terminals, print head nozzles, and silver filters
on the print head unit.
fromthe | 1he print head unit contains a clear liquid preservative that is
print head unit. harmless; if it leaks onto your hand, wash it off.

white tape

* FRINT HEAD
MOZZLES

REMCNVE TAPE

Insert the print ¢ Gently place the print head unit into the compartment with the
head unit print head nozzles down_, the terminals up, and the silver filters
' facing the front of the printer.
e You don't need to press on the print head unit. When you close
the compartment cover, the print head unit becomes secure.
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1"l_...__-
Close the ¢ Press down firmly on the two white dots on the top of the cover
until it snaps securely closed.
e You actually hear two distinct clicks as the cover engages with
cover. the compartment base.
o Make sure the sides of the gray compartment cover touch the

black base of the print head compartment.

compartment

(5D
Reinstall the ¢ Be sure to insert the tanks into the correct slots.

ink tanks you
removed earlier.
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.6

Close the
printer's cover,
and turn on the

printer.
7
Complete  * Perform the thorough print head cleaning procedure.
installation o If you are using the Microsoft Windows Printing System,

see page 2-20.
o If you are not using the Microsoft Windows Printing
System, see pagk5 for details.
Print the test page to check the nozzle pattern.
o If you are using the Microsoft Windows Printing System,
see page 2-20.
Print the alignment page to select the best horizontal registration
for printing.
o If you are using the Microsoft Windows Printing System,
see page 2-20.
If you turn on the printer and the orangeor light flashes, see
thelnitializaton Error section on page 5-3 for details.
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Transporting the Printer
7

Nete o While the BJC-620 Color Bubble Jet Printer is small and

compact, it is not a portable printer and you need to take care
when transporting it. The printer's components, such as the sheet
feeder, may become damaged if subjected to severe vibration
during transportation. Also, your print head unit may dry out
during travel (and become unusable) if it is not capped correctly
and the ink tanks may spill if they are not taped correctly.

e The printer is intended for use with a 120V power source only.
Canon does not recommend using the printer with any other
power source or with a transformer.

If you plan to move the printer from one location to another, or if you
want to store it, follow these steps.

Press the POWER ¢ Open the cover and make sure that the print head unit is in the
home position.
button to Tur-'n off « If the carriage does not return to the home position because of a
the printer.

printer error, manually move it to the home position.

4-18 Maintaining the Printer Chapter 4



Remove all four
ink tanks.

(3)

Close the
printer's cover.

Secure the
cartridge holder to
the printer with
tape.

Wrap the ink tanks individually with clear plastic wrap or a
similar material.

Then, pack them together in a plastic bag to avoid spilling any
ink.

Press and hold the, prinT mope, and =2 buttons and press the
power button until the printer beeps. This empties the ink from the
print head unit.

Remove any paper from the sheet feeder.

Detach the interface cable and the power cord.

Open the printer’s cover again.

Use tape strong enough not to detach or break during
transportation.
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Return the paper
support and paper
output tray to their
original positions.

Secure the top
cover, paper
guide, and the
paper support
with tape.
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o

Repack the o Store the ink tanks in the box with the printer.

printer in its
original packing
materials.
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Troubleshooting |5

WO 0O O 0 9 » -

Due to today's rapidly changing personal computer environment, we have placed
troubleshooting information in a variety of places to ensure that the most accurate
information possible is available. The best way to find current information is through
our on-line support services and through our Fax Retrieval System. On-line services
include the World Wide Web, our BBS, and Compuserve.

This chapter contains very basic information to help solve printer problems. It
describes how to use Canon's various support services, covers a few basic problems,
and describes how to clear a paper jam. It also includes troubleshooting information
regarding the Microsoft Windows Printing System.

Using Canon's Support Services

This section describes where to look for help. For information on the numbers for
these services, s&etting Help from Canom Chapter 1 (page 1-3).

o If you have an operational problem:
o Look through the Windows Printing System on-screen Help for related
information.
o If you have a need for a unique printer driver:
o Contact Canon through the Web, its BBS, or CompuServe.
o If you are an MS-DOS user (and do not have Windows):
o Use Canon's Fax Retrieval System to obtain information regarding how
to use the printer with your MS-DOS applications.
e If you have a hardware problem:
o Call the Customer Care Center.

5-1 Troubleshooting Chapter 5



Identifying Your Printer Problem

Before contacting Canon, identify your printer problems and make sure you have
the following information:

e Product name - BJC-620

Serial number

Place of purchase

Nature of problem

Steps you have taken to solve the problem and the results

The serial number is located on the label on the back of the printer:

p
Canon XXXXXX

120V e B0Hz 0.5A

| A NEEEXNNN—
; ) MO, B T —— SERIAL

! CANDN INC. (AT MLMEER
L.

Attempting to repair the printer yourself may void the limited warranty as to that

wom  repair. See the limited warranty information at the back of this manual for details.
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General Problems

The most basic problems you may encounter are "the printer does not
print* and "your print quality is not satisfactory."

o If the printer does not print
o Check all your cable connections
o Check your Microsoft Windows Printing System setup
o Check your computer configuration

o If your print quality is not satisfactory
o Clean the print head unit
o Clean the print head unit five times
o Replace the ink tanks

Initialization Error

The first time you turn on the printer, it performs an initialization
process and flushes the print head unit to make sure the nozzles are
clear. This takes approximately three minutes. It is done only once - the
first time you turn on the printer.

As the printer flushes the print head unit, various lights flash and then
stay on. These lights indicate where the printer is in the cleaning
process.

If a print head unit error occurs when you turn in the printer, the orange
ERROR light and one or morBRINT MODE lights flash. Follow
these steps:

D)
Turn off ¢ Press th€ OWER button to turn off the printer.
. e Unplug the printer.
the prinfer o Wait ten seconds and then reattach the power cord.
e Remove the ink tanks.
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@

Remove and
reinstall the
print head unit

)
Turn the printer
back on

Caution

Open the compartment cover
o Press in on the tabs on both sides of the compartment
cover.
Remove the print head unit.
Reinstall the print head unit in the compartment.
Close the compartment cover.
o See page 4-16 for details

Replace the ink tanks in the correct order.
Press th@ OWER button to turn on the printer

Do not unplug the printer during the initialization. If you do, the printer
will not be initialized correctly and may not print properly. Wait until
the POWER light stops flashing and the printer goes on-line before
performing any other print operations.
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Clearing Paper Jams

When a paper jam occurs, the ERROR light comes on and the printer
goes off-line. If you are using the Microsoft Windows Printing System,
you see this Status Window:

= Carven BICE2D on LPT1

L2 [

Printing: WMicrasal 'Woed - FAX_WS 000 —

CD Clear Paper Jam

D)

Gently pull the e« Press ON LINE or click the Resume Printing button in the Status

paper out with Window to continue printing.

one hand while
holding down the
printer with the
other hand
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If the paper e Turn off the printer.
tears off e Open the printer’s cover.
. e Remove the paper left inside the printer.
inside the

Press theower button to turn the printer back on. The printer is now
printer, ready for printing.
follow e If the platen is soiled, wipeclean with a dry cloth. Seeleaning the
these steps Printer on page 4-3 for details.

Ink Problems
Ink Tanks Continually Run Out of Ink

If your ink tanks seem to run out of ink before you think they should, make sure
you are following these guidelines.

e Turn off the printer only when the print head unit is in the home position.
When in the home position, the print head unit is capped; this protects the
print head nozzles and ink cartridges from damage or drying out.

e Only transport the printer when the print head unit is in the home position

o Never unplug the printer or turn off a power strip to which the printer is
attached when the printer’s power is turned on.

e Try not to clean the print head unit unnecessarily. The print head cleaning
procedure consumes a small amount of ink.

o Do not unplug the printer unnecessarily. The printer performs the print
head cleaning operation, which uses a small amount of ink, every time
you plug it in.

e Do not print documents with solid background colors. This consumes an
excessive amount of ink.
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Ink Tanks Incorrectly Installed

2% 1)

Remove each
ink tank that
isinan
incorrect slot.

@

Install the ink
tanks in the
correct slots.

If you find that the ink tanks are installed in the wrong slots, follow these
steps:

+« Examine each tank to see if another color of ink has come into the tank
and mixed with its ink.
e If this has happened, replace the ink tank with a new one.

o Execute the custom cleaning again for each of the colors that were
installed incorrectly.

e You can repeat the custom cleaning procedure several times if the colors
do not seem accurate.

o If the problem persists, replace the ink tanks with new ones.

Troubleshooting The Microsoft Windows Printing

System

When a problem occurs, the Status Window displays the printer error message.
To resolve the problem, pres$o view the on-line help and then follow the
instructions.

The following table contains additional information to help you solve any BJC-
620 printer operation problems that may occur with the Microsoft Windows
Printing System.
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Problem Cause Solution
The Microsoft | The Microsoft Set the Canon BJC-620 as the default printer as
Windows Windows Printing | follows.
Printing System for the When using Microsoft Windows 95:
System does n¢gtBJC-620 may not
work correctly | be set as the 1. Open the Printers folder and select the BJC-g20.
default printer, 2. On the File menu, click Set As Default.
When using Microsoft Windows 3.1 or Microsoft
Windows for Workgroups 3.1:
1. Double-click on the Printer Setup icon in the
Microsoft Windows Printing System group.
2. Select the BJC-620.
3. Click on Set As Default Printer.
The Microsoft Print the Microsoft Windows Printing System test page
Windows Printing | to make sure that the Microsoft Windows Printing
System may not b¢ System is installed correctly and the printer works
properly installed, | correctly. To print the test page, press the Print Te$t
Page button in the Status Window.
Note: If the same port has been selected for the BJ[C-
620 and another Microsoft Windows Printing Systern
printer, connect the other Microsoft Windows Printing
System printer to a different port (such as File). Thgn,
restart Microsoft Windows.
Output looks | The print quality | If you select the High Speed (Text & Graphics) prin
too light selection does not| quality, output tends to be light. Try High Quality Tejxt
match your or High Quality Graphics.
document.
Output appearg The resolution Changing the resolution to 360 x 360 dpi or higher
jagged selected via the | should correct this problem.
Microsoft
Windows Printing
System may be 180
x 180 dpi.
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Problem Cause Solution

Blurred or smudged| The printing option Make sure you select a Media type
ink settings do not match | appropriate for your media. If black ink is
your media. blurred on back print film or other kinds of

paper when you select a high resolution (shich
as 720 x 720 dpi), select Photographic
Quality as Print Quality in the Quality dialog
box/tab. If black ink is still blurred, try to
increase the brightness of black in the
Graphics dialog box or Graphics & Color tab.

Color output looks | The Halftoning method]| If you print graphics or scanned images, syich

rough selected via the as photographs, selecting Solid haiftoning
Microsoft Windows loses details on the output. If you print
Printing System may bg graphics, selecting Patterned is
Solid. recommended. If you print scanned images,

select Smooth halftoning. When you select
720 x 720 dpi, use Smooth halftoning for
optimum print quality.

Prints only in black | Gray Scale Printing mayMake sure Gray Scale Printing is not

be selected, which selected. If it is not selected, see your
prints all documents in | application’s printing option settings. If thele
black and white. is a color printing option, make sure it is
enabled.
Color output is not | The printing option The following printing option settings take

what you expect settings do not match | effect on output:
your document.

Media type—Be sure to select the media
type that corresponds to your media.

Resolution—Select a higher resolution for
higher quality output and a lower resolutiol
for lower quality output.

—4

Print Quality—Select High Speed (Text &
Graphics) for draft printing, High Quality
Text for text printing, and High Quality
Graphics for graphics printing.

A4

Halftoning—Select Solid for text and simply
graphics printing, Patterned for printing
graphics that contain large solid color, or
Smooth for printing scanned images.

See the oriine help for details.




Problem

Cause

Solution

High gloss film is
soiled with black ink
at a high resolution

Black ink on high gloss
film does not dry easily,

When you print solid black areas at a high
resolution (720 x 720 dpi)—such as in
reversed characters—on high gloss film,
black ink may adhere to the printed lines. |
this happens, select Photographic Quality
Print Quality in the Quality dialog box/tab. |
this does not solve the problem, try to
increase the brightness of black in the
Graphics dialog box or Graphics & Color t3

== D
(7))

b.

Printing is slow

Printing options may
be too complicated,

Try to set all printing options to their default:

360 x 360 dpi, High Quality Text.

These print options affect the printing speg
as follows:

Dots per Inch—Printing at a lower resoluti
(180 x 180 dpi) is faster and at a higher
resolution (720 x 720 dpi) is slower.

Print Quality—High Speed (Text &
Graphics) is the fastest, and High Quality
Graphics is the slowest.

Try changing these settings.

~—+

d

Paper does not fee
correctly

dYou may not have
selected the Paper
Source that is suitable

for your media type.

When you print High Gloss Film or heavier

weight print media, be sure to select Manugal

Feed as the paper source.
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Technical Notes

If you have connected the BJC-620 to your computer and have turned it on, but your
computer says it cannot find the printer, you may need to modify your BIOS setup.

This section describes the BIOS setups for several computer configurations. Our on-
line services are updated with this type of information as it becomes available. If you
are having a unigue problem and do not see your computer here, be sure to use our
on-line services (Web, BBS, CompuServe). See Getting Help From Canon in Chapter
1 (page 1-3) for details.

BIOS Setups for Various Systems

ACER View 11D

* Press CTRL ALT ESC

» Use Arrow Key to Go to Advanced
* Select Peripheral Configuration
 Cursor to Parallel Port Mode

e Press Enter

e Select ECP

 Press FIO to Save and Exit

AT&T Globalyst 363 TPC

 Hit F2 to Enter Setup

* Hit up Arrow Key to Go to Advanced

» Cursor Down to Integrated Peripherals
» Cursor Down to Parallel Port Mode

» Use Gray Plus Key to Select ECP

* Press Escape Twice

» Cursor Over to Exit

» Select Save Changes and Exit
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Compaq 9234, 9222, 9221 BIOS
» Go to Device manager
* Click on the + Sign By Ports
» Double-click on the ECP Printer Port
» Select Resource Tab, and Make a Note of the Resources Settings
» Cancel Out of the LPT Port Properties
* Remove the ECP Printer Port From Device Manager
» Restart the Computer and Press the FIO Key (at 2 beeps or any other appropriate
prompt)
* Press Enter, and Enter Again to Acknowledge Openings Messages
» Select Setup
» Select Communications
» Go to the LPT Port and Select the Resource Group that Matches the one Noted in
Device Manager (setup 4) ***but without the dma***
» Exit and Save, the System will reboot, and should detect and configure a "NON
ECP" Printer Port including the Printer

COMPAQ Presario CDS 972
» While Rebooting, Hit FIO to Enter Setup
* Click on Communications Section
* Click on LPT PORT MODE
 Select Bi-directional
* Click (or Hit) Exit
* When it asks you if you want to save, Hit "Y" for Yes

Dell Dimension P100

* Press Delete to Enter Setup

* Press Delete to Enter Setup

* Press ALT P

 Cursor to Parallel Mode

» Change to PS/2 or ECP by Using Arrow Keys
* Pressing Escape will Exit and Save Changes
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Digital 930 BIOS Instructions

* Press F2 to Enter Setup

» Use up Arrow Key to Go to Top Toolbar

» Use Right Arrow Key to Go to Advanced

* Hit Enter on Advanced

* 3rd Item is Parallel Port Mode

* Use Plus Key to Change From Compatible to Bi-directional
* Hit Escape to Go to Main Menu

» Select Save Changes and Exit

* Notice Changes and Have Been Saved (continue)

Gateway 2000 P575

* Reboot Press F 1

» Select Advanced Setup

* Select Peripheral Configuration
 Cursor to Parallel Port Mode

e Press Enter

» Select "ECP"

» Press F10 to Save and Exit

Gateway Pentium 90 BIOS Setup

* Press Fl to Enter Setup

» Cursor Over to Peripheral Configuration

 Hit Enter

e Cursor Down to Parallel Port Mode and Hit Enter
» Select ECP-EPP Mode

 Hit Enter

* Press Escape

» Press F10 to Save and Exit

» Select "Save Settings and Exit"

 Hit Enter

GENISYS Pentium S BIOS

* After Rebooting, Press DEL to Enter Setup

» Cursor Down to Chipset Features and Hit Enter
» Cursor Down to Onboard Parallel Mode

» Use PageUp key to Select ECP Mode

* Press Escape

* Press F10 to Save Settings and Exit

* Press "Y" for Yes

* Hit Enter



IBM Aptiva
* Fl to Enter Setup
» Advanced Options
 Select Input/Output Options
* Press Enter
* Highlight Parallel Printer Options
» Select Using the Right and Left Arrow Keys

IBM Thinkpad BIOS Instructions

* Hold FI Down While Turning on Computer
» Cursor Over to Config Icon

e Press Enter

 Cursor Over to Parallel

 Hit Enter

 Cursor Over to Bi-directional and Hit Enter
» Go to Bottom and Hit OK

» Go to Bottom and Hit OK

» Cursor Over to Restart and Hit OK

MICRON T133 w/Phoenix BIOS

* Press F2 to Enter BIOS

» Cursor to Advanced System Setup and Hit Enter
 Cursor to Integrated Peripherals and Hit Enter

* Cursor to LPT MODE: (AT)

» Use Gray Plus Key to Select ECP

 Hit Escape Twice

 Cursor to Exit and Hit Enter

* Answer "Yes" to Save Settings

Packard Bell 411 & 102 CP

* Press Fl to enter Setup.

* Hit Right Arrow Key until you get to Advanced.

* Cursor to Peripheral Configuration

* Hit Enter

» Cursor Down to Parallel Port Mode (will say Bi-directional)
* Hit Enter

» Cursor Down to ECP and Hit Enter

* Press Escape

* Hit FIO to Save and Exit

* Hit Enter




Packard Bell 823 CDTW

* Press Fl to Enter Setup

» Arrow to Integrated Peripherals

» Change PARALLEL PORT MODE to AUTO
* Press Escape Twice

» Save and Exit

Packard Bell Excel 2005 Plus
* Press CTRL ALT S to Enter Setup
» Select ADVANCED SYSTEM Setup
» Hardware Configuration
» Change Parallel Port Mode to "OUTPUT ONLY"

Packard Bell Excel 461

* Press F2 to Enter Setup

» Select Submenu

* Select Integrated Peripherals

* Press Enter

» Tab to LPT MODE will say "Bi-directional" press +1- to change value to
"OUTPUT ONLY"

* Press Escape Twice

» Save Changes and Exit

Packard Bell Legend 812 CP
* Press F2 to Enter Setup
* Hit Right Arrow Key to Go to Advanced
* Hit Enter
» Screen Shows Integrated Peripherals, Hit Enter
» Cursor Down to LPT Mode: Output Only
* Hit Plus Key to Go to ECP Mode
* Hit Escape
* Hit Escape
» Select Save Changes and Exit
* Hit Enter
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Packard Bell Legend 822 CD

* Press Fl to Enter Setup

* Hit Right Arrow Key to Go to Advanced
* Hit Enter

» Screen Shows Integrated Peripherals, Hit Enter
» Cursor Down to LPT Mode: Compatible
* Hit Enter

 Hit Arrow Key to Go to ECP Mode

* Hit Enter

 Hit Escape Hit F10

» Select Save Changes and Exit

* Hit Enter
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Printing Method
Bubble jet ink on-demand

Paper Handling
Automatic feed
Manual feed

Sheet Feeder Capacity
Maximum thickness of stacked paper: 0.35 in (9 mm)

Plain paper Approximately 100 sheets
Bubble Jet paper Approximately 100 sheets
Coated paper Approximately 80 sheets
High resolution paper Approximately 80 sheets
Transparencies 50 sheets

Back print film 50 sheets

High gloss film 1 sheet

Fabric sheets 1 sheet

T-shirt Transfers 1 sheet

Greeting cards 1 sheet

Brochure paper 1 sheet

Thick paper 1 sheet

Envelopes 15 envelopes (U.S. Commercial number Envelopes 10 o
Paper Size

Letter 8.5inx11lin

Legal 8.5inx14in

A4 210mm x 297mm

B5 182mm x 257mm

U.S. Commercial number 10 envelope 9.5inx 4.1 in

European DL envelope 220 mm x 110 mm
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Recommended Paper Types
Coated paper

High resolution paper
Transparencies (OHP film)
Back print film

High gloss film

T-shirt transfers

Fabric sheets

Greeting cards

Brochure paper
Envelopes

Paper Weight

17 to 24 Ib (64 to 90 g/m2) with automatic feed
17 to 28 Ib (64 to 105 g/m2) with manual feed
Paper Thickness

Less than 0.008 in (0.2 mm)

Print Speed

High Speed (Text & Grahics) mode

High Quality Text mode
High Speed (Text & Graphics) mode

Print Width
Maximum

Line Feed Speed
Approximately 100 ms per line at 1/6-in line

Printing Direction
Bi-directional

Canon Coated Paper LC-101

Canon High Resolution Paper HR-101
Canon Transparencies CF-102

Canon Back Print Film BF-102

Canon High Gloss Film HG-101

Canon T-Shirt Transfers TR-101

Fabric Sheet FS-101

Canon Greeting Cards GC-101

Canon Brochure Paper BP-101

U.S. Commercial number 10 or Europea

300 cps at 10 cpi

205 cps at 10 cpi

Approximately 0.7 to 1.3 ppm

(8 x 10 inch full coverage of printable ar

8 inches (203.2 mm)
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Printable Area—Papers
The shaded portion in the following figure shows the printable area for papers.

T
Margins Inches mm
Right 0.251in 3.4 mm
Left 0.25in 3.4 mm
Top 0.33in 8.5 mm
Bottom 0.28in 7.11 mm

Printable Area—Envelopes
The shaded portion in the following figure shows the printable area for envelopes.

"=' _'-:I
|Tl.r._
g )
L
I
Margins Inches mm
Right 0.25in 6.4 mm
Left 1.24in 10.4 mm
Top 0.12in 3.0mm
Bottom 0.28in 7.11 mm
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Print Head Unit
Type:

Ink Tanks

Black

Type:

Ink color:

Number of characters
printed:

Color

Type:

Ink color:

Number of characters
printed:

64 nozzles for each color

BJI-201 Bk HG

Black

Approx. 450 pages in High Quality Text mode (5% coverage)
Approx. 800 pages in High Speed (Text & Graphics) mode (5%
coverage)

BJI-201 C, M, Y

Cyan (C), Magenta (M), Yellow (Y)

Approx. 210 pages in High Quality Text mode (7.5% coverage
for each color)

Approx. 300 pages in High Speed (Text & Graphics) mode (7.5%
coverage for each color)
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Interface To receive information regarding the interf
8-bit parallel call Canon’s toll-free Fax Retrieval Syste
4345 and request the BJC-620 Interfage S

Acoustic Noise Level Per ISO 9296
Under 45 dB(A) in High Quality and High Speed modes

Operating Environment
Temperature
Humidity 41° F to 95° F (5° C to 35° C)
10% to 90% RH (no condensation)

Storing Environment
Temperature 32°F to 95° F (0° C to 35° C)

Humidity 5% to 95% RH (no condensation)

Power Source
USA/Canada AC 120V, 60 Hz, 0.5A

Canon recommends that the printer ba use
source only.

Power Consumption
11 watts standby
29 watts maximum printing

Dimensions
16.1in (410 mm) W x 9.96 in (253 mm) D x 7.2 in (184 mm) H

Weight
Approx. 9.9 Ib (4.5 kg)
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Operator Panel

POWER LIGHT—INDICATES THAT THE PRINTER
IS ON.

POWER BUTTON—TURNS THE PRINTER'S POWER
ON OR OFF.

ERROR LIGHT—LIGHTS WHEN THE PRINTER IS OUT
OF PAPER, PAPER IS JAMMED, OR ANY OTHER
PROBLEM EXISTS.

— ON LINE LIGHT—LIGHTS WHILE THE PRINTER IS ON-
LINE, INDICATING THE PRINTER IS READY FOR
PRINTING.

— ON LINE BUTTON—TURNS THE PRINTER ON-LINE
OR OFF-LINE.

FF BUTTON—FORCES A FORM FEED,
WHICH EJECTS THE CURRENT PAGE.

PRINT MODE LIGHTS—IMNDICATE THE PRINT ——
MODE. WHEN YOU USE THE MICROSOFT

WINDOWS PRINTING SYSTEM, THE WINDOWS
PRINTING LIGHT IS ON. DURIMG PRINT HEAD
CLEANING, THE CORRESPOMNDING LIGHT

BLINKS AS EACH HEAD 1S CLEAMED.

PRINT MODE BUTTON—SELECTS A FRINT QUALITY AND —
A PAPER TYPE. ALSO IDENTIFIES THE COLOR FOR PRINT
HEAD CLEANING—BLACK, CYAN, MAGENTA, YELLOW,

=1 BUTTON—SELECTS ENVELOPE MODE.

=1 LIGHT—INDICATES PRINTING IS ON ENVELOPES.

INK LIGHT—INDICATES THE INK CARTRIDGES NEED TO BE CHECKED.
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Using the BJC-620in a
Network Environment
@ 0o 9 9 < (" ()

You can use the BJC-620 that is connected locally to your computer
your network.

Sharing a Printer

You can share the BJC-620 in a Microsoft Windows 95 or Microsoft
Workgroups 3.1 environment as described in this appendix.

Microsoft Windows 95

1. Inthe Printers folder, select the BJC-620 you want to share.

2. Choose Properties from the File menu.

3. Open the Sharing tab and select Share As. Enter a share name
in the appropriate box, and then cliokK .

For details, see the Microsoft Windows 95 documentation andlconsu
administrator for specific information about your network.

Microsoft Windows For Workgroups 3.1

1. Inthe Printers folder, select the BJC-620 you want to share.

2. On the toolbar, click tt# button, or choose Share Printer As

3. Inthe Share Printer dialog box, enter a share name andiclick o
box. Then clickOK.

For details, see the Microsoft Windows for Workgroups 3.1 docume
your network administrator for specific information about your netw
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Connecting to a Network Printer

When you install the Microsoft Windows Printing System without connecting to a
program asks whether you want to redirect the selected port to a network printer o
Windows Printing System without a printer. After you select a port, you seeithis sc

% LPT1: has not been redirected to o network. printes.

: Selected Port 15 Mot Directed To A Network Printer

=i | Redirect the port to a netwoek prinder.

2ol The printes will be connected to this port later, o
e the port mill he edwected to a netwodk prinbed late:

&b

Select « If you want to connect your computer to a network printer that is being shar
Network The Network Printer Resources dialog box appears.

Nctwork I;rintﬂ} Hrsnu r-:c.ﬁ.

Hetwork Path: I - _"__i

(] Alway: Browse

Show Shared Prnters on
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2>
Specify Select the network printer by selecting the network printer’ th
Network ° P g ° e

Printer

Hetwork Path: |\.‘|HAT\HJE-62'CI _ J

[ Always Browse

Show Shared Ponters onc

Shaped Printere on WWMAT:

GED

Choose  * The network printer is connected to the selected port.
ok ° Choose OK to continue installation.

Select the Port|<] tor Printers Inztallation
j—r

ﬁ T anslall an adddional printes. mave a pord (o the Post{s] With Priners To Install boa.

Foale Avalablde for Ponder Inelsllation: Poutn] With Pristean To Imstall:

LPTE  |mol prezend] 3 LPTT: WAMATABJC-620 Canon BJC-G20 F
|
|

LPTE  [mol prezent]

Do a |
Tt e vl
« s kirter e

| Indlall the zelected printess oo the sslected posts.

You can connect to a network printer after installing the Microsoft Windows

For details, see the Microsoft Windows 95 or Microsoft Windows for \Work
documentation
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